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Trademarks 
Unigraf, UCD, UCD-422, UCD-412, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPortµ and the DisplayPortµ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

The Adopted Trademarks HDMI, High-Definition Multimedia Interface, the HDMI Logo and HDMI Port 

Logo are trademarks or registered trademarks of HDMI Licensing Administrator, Inc. in the United 

States and other countries. 

USBµ, USB Type-Cµ and USB-Cµ are trademarks of USB Implementers Forum Inc. 

HDCP is a trademark of Digital Content Protection LLC. 

Altera and Intel FPGA are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or other 

countries. 

Windows® is trademark of Microsoft Corporation. 

macOS® is a trademark of Apple Inc. 

Linux® is a trademark of Linus Torvalds. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, under 

normal use and service, for twelve (12) months from the date of purchase from Unigraf or its 

authorized dealer. 

If the product  proves defective within the warranty period, Unigraf will provide repair or replacement 

of the product. Unigraf shall have the whole discretion whether to repair or replace, and replacement 

product  may be new or reconditioned. Replacement product  shall be of equivalent or better 

specifications, relative to the defective product, but need not to be identical. Any product  or part 

repaired by Unigraf pursuant to this warranty shall have a warranty period of not less than 90 days, 

from the date of such repair, irrespective of any earlier expiration of original warranty period. When 

Unigraf provides replacement, then the defective product  becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-4XX Series products meet the essential health and safety requirements, is in conformity with 

and the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is a User Manual of UCD-422 Gen2, UCD-422 and UCD-412 test devices, that are USB-

connected video interface test units for use with a computer. 

The purpose of this guide is to 

¶ Provide an overview of the product  and its features. 

¶ Provide instructions for the user on how to install the software and the drivers. 

¶ Provide instructions for the user on how to update the FW of the unit. 

¶ Introduce the HW features of the UCD-4XX units. 

¶ Provide instructions for the user on how to use UCD Console SW. 

Product and Software Version 
This manual explains features found in UCD Console SW Bundle 3.7. Please consult Unigraf for 

differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and FW 

versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is formatted 

as follows. Please read these notes carefully. 

Note: This text is an important note 

 

Warning: This is a warning about a direct risk for the functionality of the device 
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 INTRODUCTION 

Product Description UCD-422 Gen2, UCD-422 and 

UCD-412 

Product Features  

¶ UCD-422 Gen2, UCD-422: Reference Sink and Source for verifying HDMI connected devices. 

¶ UCD-412: Reference Source for verifying HDMI connected sinks. 

¶ HDMI 2.1 compatible. Supports FRL and TMDS signaling. 

¶ Supports HDMI video and audio up to 10K@30 Hz, 8K@60 Hz (YCbCr 4:2:0),  

4K@120 Hz (YCbCr 4:2:0) 

¶ Supports Display Stream Compression (DSC), and Enhanced Audio Return Channel (eARC) 

¶ Compatible with HDCP versions 1.4 and 2.3 

¶ 2 GB on-board high-speed video frame buffer 

¶ High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description  

UCD-422 units consist of a multimedia signal input stage with on-board frame buffer, an internal 

pattern generator, a control stage, and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format. The Interface and Control stages are either passing the 

captured data directly to the USB interface or storing it to the frame buffer. The internal pattern 

generator is able to source a signal for testing sink and branch units. The Interface & Control stages 

are receiving instructions from the host PC to configure and control the functionality of the unit.  

Please find below logical diagram of UCD-422 unit 

Delivery Content  

¶ Product shipment contains: 

¶ The UCD-422 Gen2, UCD-422 or UCD-412 unit 

¶ AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

¶ USB 3.0 compliant cable for host PC connection 

¶ HDMI 2.1 grade HDMI cable 

¶ Micro-USB type B compatible cable needed for FW programming. 

¶ Ethernet cable needed for FW programming. 

 

UCD-422

Control & Interface
USB 3.0

Host PCHDMI Internal
Pattern Generator

On-board

Frame Grabber
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Connections  

The image below indicates the connections in UCD-422 unit and their description. 

Name Description 

HDMI in HDMI 2.1 compliant input from the upstream Source 

HDMI out HDMI 2.1 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

Programmer USB interface used in device FW update (behind a cover) 

Ethernet Ethernet interface used in device FW update (behind a cover) 

 

Note: Capturing and sourcing high resolution video modes, especially 4K 8K and 10K video modes and the 

120 Hz frame rate set stringent requirements on the video cables and connectors.  

 

Warning: In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first , and after that connect the USB cable to the PC. 
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Safety and Operational Precautions 
Please find below the Safety Precautions  for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings  within the text of this manual.  

These Precautions and Warnings  are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions and 

Warnings.  

¶ Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and cabling 

to the Power Adapter are intact. In case there are any doubts about the condition of the Adapter 

or cabling, stop using it immediately. 

¶ It is important to ensure that the used AC input voltage is within the specified range (100 to 240 

Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not connect 

the device. 

¶ UCD devices are rated for indoor use only. They are rated for Pollution Degree 2 as defined in 

IEC 61010-1. This classification corresponds to usage in a typical office or home 

environment. Under normal use, only dry, non-conductive pollution occurs. Occasionally, 

temporary conductivity caused by condensation can be expected. Temporary condensation 

occurs only when the product is out of service.  

¶ When installing the unit, connect the Power Adapter to the UCD device first, after that connect 

the AC plug. Please disconnect the USB cable to the controlling PC and remove cabling to DUT 

while connecting the power input cables. 

¶ It is forbidden to open the housing of the UCD device without written permission from Unigraf. 

Failure to comply with this rule will void the warranty of the unit. 

¶ UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes is 

forbidden. 

¶ Use UCD equipment only in its specified ambient temperature and humidity.  

¶ In order to ensure that the UCD device and associated SW will operate properly, please ensure 

that the PC used for controlling the UCD device complies with the minimum requirement set by 

Unigraf. 

¶ Please keep UCD software updated by regularly checking the updates on Unigraf download page 

(https://www.unigraf.fi/downloads/). Please update the device firmware to match the installed 

software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/. Please, note that there are separate packages for Windows, 

macOS and Linux 

The installation package is a bundle between the components needed for UCD Console SW and fo 

TSI SDK. The bundle contains the following items: 

Drivers (installed during set up)  

UCD Console SW (installed during set up) 

License Manager (installed during set up) 

Device configuration utility (installed during set up) 

Packet Editor (installed during set up) 

TSI SDK 

User Manuals including this document.  

In some cases, also the firmware of the unit needs to be updated. If in doubt, please contact Unigraf. 

Note: The software should be installed before connecting the UCD unit to the computer. 

 

Note: System administrator's privileges are required for performing installations. 

Software Installation 

Windows  

Install *.exe file from the package.  

Start installation by running application SoftwareBundle_ X.X.XXXX. 

The welcome page is displayed and shows the software package release version. 

The user is also asked if he/she wants to: 

Create a desktop shortcut 

Install the Visual C++ redistributable (needs to be present on Windows) 

Install Unigraf USB drivers 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

 

macOS 

Install *.pkg file from the package. This is a universal binary for ARM and Intel x86. 

Start installation by running application SoftwareBundle_ X.X.XXXX. 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

Note: If you are downgrading, please remove the Unigraf UCD Tools folder from the Applications 

folder before starting installation. 

Note: If installation fails, remove the Unigraf UCD Tools folder and any possible copies from the 

Applications directory and try again. 

 

https://www.unigraf.fi/downloads/
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Linux  

Linux extract the *.tar.gz file. You will find two install scripts (install-libfuse.sh and install.sh). 

In the Files app select each script in turn, right click and select Properties to open the 

Properties dialog. Toggle the Executable as Program button. 

In the Files app open a terminal window by unselecting any selected files and right clicking and 

selecting  Open in Terminal to run the scripts (order is important).  

In the terminal type:  sudo ./install-libfuse.sh 

You will be prompted for you password.   

Type: sudo ./install.sh  

You will be prompted with: 

Please proceed to 'Software & updates' application to tab 'Other Software' and uncheck 

checkboxes or remove 'cdrom' entry from /etc/apt/sources.list file. Otherwise you will have 

problems during UCD Console package installation. If you are already done, enter the key 'y'. If 

not - 'n' 

For Ubuntu just enter y. For debian follow instruction. 

You will then be prompted again with: 

Please proceed to 'Software & updates' application to the first tab and set check box 'Officially 

supported (main)'. Otherwise you will have problems during UCD Console package installation. 

If you are already done, enter the key 'y'. If not - 'n' 

For Ubuntu just enter y. For debian follow instruction 

Answer y for additional prompts. 

The Ucd Tool Installer Setup app should now be running. 

Select Next> 

Select radio button for Install for all users or Install just for me. 

You are asked to Choose Installation Directory. Do NOT choose the default 

(/root/Unigraf/Unigraf UCD Tools at time of writing). Select a directory that is easy to access 

and remember. 

Note the warning: Installing in existing directory. It will be wiped on uninstallation. 

Select Next> Install and Finnish. 

Navigate to the Unigraf UCD Tools directory under the installation directory and double click 

the app you want to run (UCDConsole.AppImage for example). 
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Firmware Update Procedures 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible operation roles present in the UCD unit. A firmware 

set for the selected operation roles is created and the firmware set is programmed to the device. 

Please contact Unigraf for details. 

Updating from Earlier FW Versions  

UCD Firmware versions prior to 1.8.52 (see Help > About on Consol) do not support the procedure 

described here. Follow the instructions in Appendix G Firmware Recovery Procedure with Quartus 

Prime in this manual. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do not 

power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-4XX device, perform the following 

steps: 

u Connect the UCD unit to a power supply and connect the USB cable. 

u Open UCD Console SW. Select Tools  > Firmware Update . UCD Config will open. 

UCD Config  

The first page of the utility indicates the firmware component versions present in the package. Select 

Enable advanced mode  checkbox if you want to customize the installation (possibly to downgrade 

firmware for example). Enable patching (Internet connection is required)  check box is not relevant 

for UCD-4XX devices. 

Select Next  to proceed. 
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UCD Device Selection  

From the list of connected UCD devices please select the one that you want to update. Click Next.  

 

Review updates  

A new dialog lists: 

u FW components available in the UCD device 

u Current FW version (from) 

u FW to be installed (to) 

 

Note: Selecting individual components for update is only enabled in Advanced Mode . 

Click Start to start the FW update procedure. 

 

 

. 
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Advanced Mode  

Advanced mode allows users to select individual components to update. Click Next  to review the 

components and start the update procedure. 

 

Configuration in progress  
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During the installation, you will be prompted to power cycle the device (power off, wait for 10 seconds 

and then power the device on again). Select OK to proceed. 

 

After the update has finished, click Next to see a summary and select Finish  to complete. 

Please note that the update proceedure may take several minutes to complete. 

Recovering Failures in FW Update Procedure  

If FW Update procedure fails (e.g., when updating from an earlier FW that does not support the 

procedure described here ) refer to Appendix G of this manual for instructions in Firmware Recovery 

Procedure with Quartus Prime.  

Once FW Recovery procedure has been done and a Firmware version supporting UCD Firmware 

Configuration tool has been installed, all future updates can be done using this tool. 
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Firmware Downgrading 
The previously released Unigraf SW Bundle 2.4.XX package does not contain UCD Device Firmware 

(FW). In case UCD device has been installed with the FW delivered with Unigraf 3.X SW Bundle, and 

version downgrade is needed, also UCD Device Firmware has to be rolled back.  

Please follow the procedure below: 

1. Download the latest Console 2  SW Bundle (2.4.XX) from Unigraf download page at 

unigraf.fi/downloads. 

2. Run the application SoftwareBundle_ 2.4.XX.exe  in the package to install the package. Please 

do not launch UCD Console application yet. 

3. Download Console 2: FW Package 2.3.38  from the same download page 

4. Run the application FirmwarePackage_2.3.38.exe  to copy UCD device FW in a proper folder 

in your PC 

5. Launch UCD Console  

6. Select Tools > Firmware Update  to start UCD Config  utility 

7. In UCD Config select Enable advanced mode  

8. Select the device. Click Next.  

9. In UCD Modules  select the module titled MFMN4XX F.X.X.X/N.X.X.X 

10. Click Next . Click Start  to start programming FW to the connected UCD Device 
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License Manager 

Licensing  

The features of UCD Console SW are divided into groups based on the target use of the device. Most 

basic features can be used by default, and more advanced feature groups are enabled by dedicated 

licenses. When the licenses are present, the related part of the GUI will be shown, or the related 

control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys . Each License Key enables a 

dedicated function in one device. Each device has its dedicated Seed Number . Each License Key  is 

tied to one Seed Number . License Keys can be freely used in any number of PCs 

License keys are managed with UCD License Manager . The License Manager can be found in the 

Tools  menu of UCD Console SW. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI  

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices please 

Select  the device in question. The serial number and the seed number of your device are printed in 

a sticker attached to the bottom of the device.  

The Rescan¤ button will re-scan the system for installed hardware. 

Managing Licenses  

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number . Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 

Adding New License Keys  

To add a new license key for a device, please enter the characters from the license sticker to the field 

for new licenses. The License Manager will automatically move the caret across the edit boxes during 

typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click Install. The license is authenticated and if it is valid, the 

license will appear in the list of installed licenses. If the key fails to authenticate, an error message is 

displayed. If this happens, please make sure that the key has been typed correctly and that the seed 

number on the license key sticker matches the seed number displayed in UCD License Manager. 

Click the Search inverted triangle at the upper right to view the Find edit control. Enter a search 

keyword: The license list is updated to show names that contain the keyword.   
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Note that to avoid confusion, some letters will never appear in a license key because they resemble 

numbers: For example, capital 'G' and number '6' are very similar when printed with small font. When 

in doubt, use numbers. 

Also, please note, that characters that cannot be part of valid license key are not accepted as input. 

When appropriate, an automatic conversion is applied while typing: For example, lower case letters 

are converted to upper case automatically. 

Managing Installed Licenses  

The Installed licenses list shows all installed licenses for the selected device. The list shows the name 

of the license and the actual license key characters. 

Import: Install licenses from an INI file for the currently selected device. 

Export: Save installed licenses for the currently selected device into an INI file for 

backup and distribution to other PCs.  

To export license(s), select the license(s) to be exported and then click the 

Export button. Please note that licenses from multiple devices can be 

exported into the same INI file. 

Remove Selected: Uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button 
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UCD Console 
UCD Console SW is graphical user interface (GUI) for UCD family test equipment for desktop use. 

UCD Console provides the user access to all features of the unit. UCD Console also includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display interfaces and 

assist in problem detection.  

The various features of the UCD unit are divided into interface specific screens and tabs. Each tab 

contains data and controls for a specific feature.  

Device Selection  

A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console is launched, the dialog provides a list of Unigraf UCD devices connected in the 

PC. Please select the target device by double clicking on the appropriate row. If your device cannot 

be found in the list, please confirm the power and USB connection to the device and click the Rescan 

¤ button. 

Analyzer and Generator Operation  

Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator (a 

Source device). The functionalities of the two operation modes can be found in separate tabs. This 

User Manual will explain both roles and all role functionalities. 
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Options 
Options can be found in Tools > Options . 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM format 

the files are stored with the captured color depth, with other formats the color depth is truncated to 8 

bits per color. 

Audio File Format 

Audio files are stored in WAV format. 

Displays HDCP Compliance 

Information if controlling PC is HDCP compliant, i.e. if preview of HDCP encrypted content can be 

enabled. If the display is non-HDCP compliant or when connected to the PC using RDP (Remote 

Desktop Protocol) then users will be presented with a blue background with a banner stating ­HDCP 

unauthorized®. HDCP is currently only supported on Windows OS and not supported on MacOS and 

Linux. 

Folders 

Please select the directories in the PC for saving the captured images and audio. 

DSC 

DSC temp folder: Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related configuration files and 

DSC conversion tools are stored. 

Keep auto-created DSC 

content files: 

By default, the DSC compressed content is deleted after use. If 

selected, the content is not deleted. 

Warning Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large  (appr. 400 GBytes). 

Please make sure that the content will be stored in a medium that has the required space available. 

 

DUT Testing Options 

Configure DUT Testing reports. 

Include time info in Report logs: Include system date and time in the beginning of each 

event line in created reports. 

Do not show again test sequence 

completed: 

Include system date and time in the beginning of each 

event line in created reports. 
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Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and controlling 

separate features simultaneously. To detach a tab Right -click  on a tab and select Detach Window . 

To glue the tab back to the main window, click on the red Close button  in the top right-hand corner 

of the window or press <Alt> + F4  on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

simultaneously without swapping addresses. To clone a tab Right -click  on a tab and select Clone 

Tab or Clone and Detach  to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, the UCD device acts as HDMI Sink or Receiver device. 

Analyzer functionality related controls and dialogs can be used by selecting HDMI RX tabs.  

Please note that in most UCD-4XX Series units, Generator functionality is available simultaneously 

with Analyzer. Please find the description of Generator functionality later in this manual.  

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Functionality Tabs 

Analyzer role features the following tabs: 

¶ Video preview and saving (Video) 

¶ Audio monitoring and saving (Audio) 

¶ EDID editor (EDID) 

¶ HDCP status monitor and control (HDCP) 

¶ Source DUT Testing tab 

¶ Event Log 

¶ Status information and control of the upstream link (Link) 

¶ Received InfoFrame packets (InfoFrame). 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing.  

 



  Analyzer Operation 

UCD-4XX User Manual ± UCD Console 3.8 23 

Functionality Tabs 

Link Tab 
Link tab contains the following: Behavior, Status, TMDS Status, FRL Capabilities, FRL Status, Audio 

Return Channel, HDCP Status and Configuration, Video Status and HPD. 

Behavior  

Selection of HDMI operation mode: HDMI 1.4, HDMI 2.0 or HDMI 2.1.  

Please perform HPD Deassert - Assert after change of mode. 

Status  

Channel lock: Status of Channel Lock in the four lanes and currently selected HDMI 

mode 

Error count: Contents of the SCDC Error counter registers of the UCD-422 Sink. 

Auto Adjustment Adjustment errors on lanes. 

Behavior: Assigned HDMI mode 
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TMDS Status (Only in TMDS Mode)  

Mode: Indication of HDMI / DVI mode 

TMDS Bit Clock Ratio: TMDS Bit Period / TMDS Clock Period ratio (1/10 or 1/40)  

Input Stream Lock: Indication of TMDS character lock 

FRL Capabilities (Only in FRL Mode)  

FRL Capabilities allows the user to change the way the Sink capabilities are announced in the SCDC 

capability registers of the UCD-422 Sink. 

Disable FRL: Disable FRL mode 

Capability Radio 

Buttons: 

Selection of the maximum link count and link rate capability of UCD-422 

sink. Written to FLR_Rate configuration register of UCD_422 Sink.  

Please click Re-train to apply  

FRL Start: Control of the HDMI sink®s FRL_start bit (1/0) 

FLT Ready: Control of the HDMI sink®s FLT_ready bit (1/0). 

FLT No Timeout: Status of the HDMI sink®s FLT_no_timeout bit (1/0) 

FRL Max: Status of the HDMI sink®s FRL_Max bit (1/0) 

Check Patterns: If Check Patterns in unselected then there®s no pattern verification during 

link training 

LTP Add: Additional Requested Link Training pattern in HDMI sink®s LnX_LTP_req 

(X=0-3) register. 

Re-Train: Request a new link training  

Apply: Store new settings 
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FRL Status (Only in FRL Mode)  

FRL Status displays the status of the link training and the link parameters negotiated between UCD-

422 Sink and the Upstream Source. The status is updated automatically. 

FRL Data 0/1/2/3: Indication of data flow in FRL links 0 to 3  

FFE Level: Status of Feed Forward Equalizer Level that HDMI transmitter is using 

(only in FRL mode) 

LTP Request: Currently requested FRL link training pattern.  

FRL Mode: Lane count and link rate configuration used in FRL mode 

LT Status: Status of the FRL Link Training State 

FLT Update: Status of the UCD-422 sink®s FLT_update bit (1/0) (only in FRL mode) 

FLT No Retrain: Status of UCD-422 Sink®s FLT_no_retrain bit (1/0) (only in FRL mode) 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration  

Enable and disable HDCP 1.4 or HDCP 2.3 capability of UCD-422 Sink. Duplicates of the controls 

found in HDCP tab. 

Video Status  

Video Timing and Color Details as retrieved from stream metadata. Frame rate is measured by UCD-

422 Local Sink.  

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components 

calculated by the Sink hardware. To re-calculate, click Update . Click Copy  to store the information 

to the clipboard. 
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HPD 

High: LED indicates that the HPD signal is Asserted (logical ¯high°). 

Deassert: Click button to set HPD line to logical ¯low° (de-asserted) and hence no HPD 

pulse can be generated.  

Assert: Click to re-activate the HPD line (set to logical ¯high°). 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Status  

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 

Declared as HDCP 

capable: 

The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

SST Mode Type Type when in SST mode (DP). 

Configuration  

HDCP Capable:  To inform source DUTs that TE (UCD device) is HPCD capable or not. 

Uncheck to disable. 
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HDCP 1.x and HDCP 2.x Repeater Emulation  

  

For HDMI the UCD device can simulate a HDCP repeater. Check the Repeater Simulation box to 

enable the rest of the controls. 

Depth: Depth of Repeater (maximum 4). 

Device count: The number of devices that act as repeaters (maximum 32). 

KSV Value KSV value assigned to each device. 

Receiver IDs Receiver IDs 

Status Shows HDCP authentication of repeater. 

 

The Device count can be change via the spinbox or the +/- buttons. 

Inverted triangles are used to navigate the KSV rows. 

Use the Preset dropdown to Save, Load and Remove named (saved internally) sets. 

Use the Import and Export options to load and save to files. 

Press Apply to apply settings. 

Keys  

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  
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Capture Tab 
UCD device has an internal frame buffer that can be used for continuous capture of video data. In 

addition, audio and metadata can be captured and saved for later analysis. 

HDMI Events see HDMI Link Analyser Tab Events. 

 

Start / Stop Start or stop capturing. Button label changes per action. 

Capture N frames: The number of video frames to capture. 

Format: Selection of the format of the saved video frame bitmaps. BIN, PPM, 

BMP, BIN + PPM, BIN + BMP. 

Buffer  capacity: The number of video frames that can be stored to UCD frame buffer 

using current video signal format. 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB).  

Create scenarios Define the length of the scenario. 

Events: Please refer to chapter Event Log for details of the captured events. 

Audio: Enable audio. 

Status: Status of the capture. 

Open Timeline Viewer Open Event Timeline Viewer to view the captured data. For detailed 

instructions refer to chapter seven of this manual. 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

subfolder is ¯buffered_capture_yyyymmdd_hhmmss° (e.g., 

buffered_capture_20210301_130532). 
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Video Tab 
Video tab is the Preview window for the captured video stream. 

Disable / Enable Preview  

Click the button to start or stop capturing video frames. 

Video Status  

The details of the captured video are presented below the preview window. 

First row: Cursor location, pixel value at cursor location in YCbCr and RGB  

Second row: Time stamp, Color mode, color depth, frame counter. 

Third row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Fourth row: Live preview frame rate. 

Note: HDCP preview is only available on UCD Console for Windows operating system. 

 Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. The rate is limited e.g by the USB communication between UCD test equipment and the PC. 
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Override Color Detection  

The captured video will be by default automatically converted to RGB 8 bpc for preview and saving 

based on the information in video metadata.  

By clicking Auto button, a dialog opens for overriding the automatic conversion. Captured image data 

will be interpreted based on the values set in the dialog.  

Color space: Define as which format captured data will be interpreted. 

(Auto-detect, RGB, YCbCr4:4:4, YCbCr4:2:2, YCbCr4:2:0) 

Colorimetry: Define as which colorimetry captured data will be interpreted. 

(ITU-R BT.601, ITU-R BT.709, ITU-R BT.2020) 

Bits per color Define as which color depth captured data will be interpreted. 

(Auto-detect, 6, 8, 10, 12, 16) 

Note: Please note that the color mode selection applies to the preview window only. All internal functions 

use the raw image data as captured from the input channel. 

Frame recording  

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode can 

also be enabled in this dialog. 

Buffered When checked, all input frames are captured non-drop until the on-board frame 

buffer will be full. 

When not checked, only one input frame is buffered at a time. Frames will be 

skipped if the transfer of the data to the PC is slower than the input data rate. 

Capacity of the buffer Capacity of the on board frame buffer with the selected video and color mode. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 

Recorded frames are stored by default in C:/Users/<Current user>/Pictures. Please refer to Tools > 

Options where the location of this folder can be customized. 

Open 

 

Open folder where captured frames are stored. Double click or click Open to select a frame file for 

viewing. Please refer to Tools > Options where the location of this folder can be customized. 
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Full Screen  

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen to exit full screen mode. 

Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of the 

preview image.  

Info field in the lower right side of the bottom panel lists: 

¶ Location of the cross cursor on the bitmap stating from the upper left corner  

¶ The intensity of the Red, Green and Blue components of the pixel on the cursor location in 

decimal values 

¶ The HTML HEX color code of the pixel on cursor location  

¶ In case of YCbCr color mode the intensity of the Y, Cb and Cr components of the pixel on the 

cursor location in decimal values 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

¶ Fit Window 

¶ Zoom 25%, 50%, 100%, 200%, and 500% 
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Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of the 

preview image and selecting Save as¤. The format and storage location can be selected in the 

opening dialog. The available bitmap formats are BMP, JPG, PNG and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color.  

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from the 

display interface or if the color mode conversion selected for preview will be applied.  

Previewing DSC Decompressed Stream  

In order to capture and preview DSC compressed video DSC must be enabled in Link Capabilities 

dialog in Link tab. 

Select Enable Preview  to verify that DSC compressed stream is received. 

Click Snap button to capture one frame and start the decompressor (offline in the PC). Once the 

decompression is ready, the frame is shown, and Log lists the details of the compressed image. A 

snapped DSC image can be saved as a DSC-file. 
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HDMI Link Analyzer Tab 
Capture Data Events for analysis with Link Timeline Viewer. See chapter Link Timeline Viewer for 

details. 

Link  Analy zer buttons  

Start Start capturing main link data using Main Link Capture Options.  

Open Timeline 

Viewer 

Open Link Timeline Viewer. See Timeline Viewer. 

Open storage folder Open folder in the PC where capture data is stored. Folder is the video 

storage folder defined in Tools > Options.  

Captured video, audio and data is saved in a subfolder of this folder. The 

name of the subfolder is ¯capture_yyyymmdd_hhmmss). (e.g. 

capture_20210215_093351). 

 

Main Link Capture Options  

Amount: The amount of data logged to buffer. Buffer size 2 GBytes maximum. 

Trigger Point Options  

Data capture start can occur with or without defined trigger criteria.  

Trigger criteria dropdown has four options: No active trigger, HDP assert, HDP deassert, I2C 

transaction, CEC transaction, Main Link video lock and Packet data. 
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When I2C transaction is selected, a drop down list box is enabled and visible with options: Write, Read 

and Any. Two spinboxs are enabled for I2C Device Address and I2C Register Address. 

 

When CEC transaction trigger is selected, available trigger options are shown below. 

Select trigger options via checkboxes OVERDATA_ERROR, START_TIMING_ERROR and/or by filling 

in the CEC Template Data (hex) values. 

 

When the Main Link video lock trigger is selected, available checkboxes are GXB_LOCK_RISE, 

VID_LOCK_RISE, VID_LOCK_FALL,  HDCP1_AUTH_RISE,  HDCP1_AUTH_FALL,  

HDCP1_ENC_EN_RISE, HDCP1_ENC_EN_FALL, HDCP2_AUTH_RISE,  HDCP2_AUTH_FALL,  

HDCP2_ENC_EN_RISE, HDCP2_ENC_EN_FALL, TMDS_CLK_LOCK_RISE, EXT_PIN_RISE, 

EXT_PIN_FALL. 
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When Packet data is selected: Checkbox BCH_ERROR, when checked, will start capture when a 

BCH_ERROR error occures (and only when one has occurred). Fill out packet Template Data (hex) to 

filter events to start capture. Shown below is a trigger for AVI Infoframes in general. 

 

Position  

Triggered capture timepoint s available are: Start, 25%, 50%, 75%, End.  

Events  

The following events can be selected via checkboxes: 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal 

Packets 

HDMI infoframes. Click the button to open the Event Filter Dialog. 

Packet events without checkboxes can be added via the Enter packet type edit control (0x2 for audio 

sample for example). 

 

I2C 

Capture I2C communication. Click the button to open the Event Filter Dialog. 
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Use edit control Enter packet type as hex separated by comma: to add packets manually. 

 

CEC 

Capture CEC communication. 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and recording. 

Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways. 

¶ The ­oscilloscope® panel displays the waveforms of the received audio channels.  

¶ The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display 

can be selected between ­Linear® to 100 dB. 

¶ The span of the oscilloscope preview window is defined with Playback buffer  found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Playback buffer depends on the 

sampling frequency. Please do not exceed the Main buffer set in the same dialog. Please refer 

to description of the Video Audio and Misc Options earlier in this document. 

Enable Preview / Disable Preview  

This button controls capturing the audio data. 

Select Monitored Stream  

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current Stream  

selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

­oscilloscope® panel will seem static. Signal capture can be verified by ensuring that Frame # below 

the panels is increasing. 
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Playback device selection  

The captured audio can be played back in the PC. The combo-box defines the audio device in the 

host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD-4XX EDID. Since UCD-4XX is not performing 

any audio format conversion, it might occur that the source provides an audio format that the selected 

playback device does not support. In case a conflict occurs, please change manually the EDID 

content or disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list  

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Audio Buffer Size  

The amount of buffering used in the data transfer between the UCD-4XX unit and the PC in Audio 

buffer size in Tools > Options dialog, Main buffer. Increased buffer size will ensure a smooth audio 

output but will also increase the delay between the capture of the audio stream and its playback. 

Start audio recording  

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 

Input audio mode  

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream and the 

number of audio packets captured. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID data of the UCD Sink presented to the connected 

Source Device. There are three basic functions: 

¶ Load and save data files on the host PC. 

¶ Edit contents in Editor Mode or the Hex Edit Mode. 

¶ Read and write to EDID memory for up to 4 virtual ports. 

EDID 

 

With Load¤ and Save As¤ a file can be read or written to from a PC. Please note that the program 

does not alter the contents of the file or verify its integrity during load and save operations. 

Note: Four blocks (512 bytes) are read. If the device does not support all four blocks, the non-supported 

data is replaced with zeros. 

Text EDID 

The Text EDID tabs allow viewing data in tree form. 

EDID Editor  

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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Source DUT Testing Tab 
Please refer to Appendix E for descriptions of the tests available. The tests are presented in a split 

view, the right being test categories and the left being the tests in them. 

 

Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category when 

running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 

On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open  a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 
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Test Parameters  

Each test suite has a dedicated set of test parameters. Select Configure to launch the parameters 

dialog for the selected tests. 

See Appendix E for parameter descritptions for each test category. 

Saving Test Parameters  

Test parameters can be saved in various ways. 

¶ Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

¶ Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

¶ Save parameters in Configure dialog as Presets to be later used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that Import ing and Exporting *.json files here have a different format than importing 

those described above. 
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InfoFrame Tab 
InfoFrame Tab displays received InfoFrames. Click Refresh  to update the list. Show / hide the parsed 

data by selecting Packet Info .  

Received InfoFrames  

InfoFrames tab displays in hexadecimal format the following received InfoFrames: 

¶ ACR (Audio Clock Regeneration) 

¶ ASP (Audio Sample Packet) 

¶ GCP (General Control Packet) 

¶ ACP (Audio Content Protection Packet) 

¶ ISRC1 (International Standard Recording Code) 

¶ ISRC2 (International Standard Recording Code) 

¶ OBA (One Bit Audio sample packet) 

¶ DTS (DTS Audio packet) 

¶ HBR (High Bitrate Audio stream packet) 

¶ GMP (Gamut Metadata packet) 

¶ EMP (Extended Metadata Packet) 

¶ 3D ASP (3D Audio Sample packet) 

¶ 3D OBA (3D One Bit Audio sample packet) 

¶ AMP (Audio Metadata Packet) 

¶ MST_ASP (Multi-stream audio sample packet) 

¶ MST_OBA (One Bit Multi-stream audio sample packet) 

¶ VSI (Vendor Specific InfoFrame) 

¶ AVI (Auxiliary Video Information) 

¶ SPD (Source Product Descriptor) 

¶ AIF (Audio InfoFrame) 

¶ MPEG (MPEG Source InfoFrame) 

¶ DRM (Dynamic Range and Mastering InfoFrame) 

Saving Info Frames  

Infoframe packets can be saved in a file in binary format. Click Save and in the dialog select the 

packet types of choise. File name will be of format EMP_2022-07-28T15_54_24.bin, where EMP is 

the packet type and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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Infoframe Features  

Observe features found in infoframes by selecting Features.   
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CEC Tab 
The CEC Tab is used for sending and receiving CEC (Consumer Electronics Control) protocol 

messages and data. The CEC Tab is grouped into two panels: CEC Info and CEC Controls. 

  



  Analyzer Operation 

UCD-4XX User Manual ± UCD Console 3.8 45 

CEC Info 

CEC data and received status can be seen in the CEC info panel. 

 

 

Version: CEC version number 

Operation number: CEC operation number 

Buffer status: Shows buffer status 

CEC response: Enable CEC response. 

CEC data: Shows CEC data received 

Reset All: Remove all rows 

Reset: Remove selected rows 

Refresh: Check for new data 
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CEC Control s 

 

Use CEC Controls to send data a HDMI follower via CEC protocol.  

 

Select all: Select all added items 

Send: Transmit via HDMI CEC protocol 

Add: Add an Operation code with 

parameters to be sent to various 

devices 

Remove: Remove selected items. 

Presets: Save, load, remove, import and 

export presets 
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Add 

 

 

 

Logical address: Initiator address 

Destination: Destination device 

Physical address: Physical address of device. Auto-filled 

by firmware 

Operation code: Opcode 

OP code param size: The size of operand(s). Minimum is 

0x0, maximum is 0xE. 

OP code parameter (as hex value separated by comma) Operand(s) 

Device type Select device type 

  

 

Note: Event Log can also monitor the received CEC frames 
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Remote  

The interface simulates the function of a remote control. 

 

 
Power Toggle  

 
Up 

 
Power on 

 
Down 

 
Power off 

 
Left 

  
Root menu 

 
RIght 

  

Exit 

 
Select 

   

Channel up 

Channel down 
 

Volume up 

Volume down 

 

CEC Flow 

 
Logical address (initiator)  

 
Logical address (destination) 

ADDR Physical address 
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 GENERATOR OPERATION 
When used as a Generator, the UCD device acts as an HDMI Source or Transmitter device. Generator 

functionality related controls and dialogs can be used by selecting DP TX or HDMI TX tabs.  

Please note that in most UCD-4XX Series units Analyzer functionality is available simultaneously with 

Generator functionality. Please find description of Analyzer functionality earlier in this manual.  

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Functionality  Tabs 

Analyzer role features the following tabs: 

¶ Link (Link status and configuration) 

¶ Video pattern generator (Pattern Generator). 

¶ Content Playback (Playback) 

¶ EDID editor (EDID) 

¶ HDCP status monitor and control (HDCP) 

¶ Sink DUT Testing 

¶ Adaptive-Sync 

¶ Status information and control of the downstream link (Link). 

¶ SCDC monitor (SCDC) 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing  
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Functionality Tabs 

Link Tab 
Link tab shows the status and control items for the HDMI link. 

  

HDMI Behavior  

Selection of the HDMI version to be used (HDMI 1.4 / HDMI 2.0 / HDMI 2.1). 

Status  

 

Channel lock: Status of Channel Lock in the four lanes.  

Error count: Contents of the SCDC Error counter registers of the connected Sink. 

Behavior: Assigned HDMI mode. 

Video Video signal status. 
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TMDS Status (only in TMDS mode)  

Mode: Status of the HDMI/TMDS mode (HDMI/DVI) 

TMDS Bit Clock Ratio: Status of TMDS_Bit_Clock_Ratio bit in SCDC ² TMDS Configuration 

(1/10 or 1/40) 

Scrambling: Status of TMDS_Scrambler_Status bit in SCDC ² TMDS Scrambler 

Status (1=LED on; 0=LED off) 

TMDS Control (only in TMDS mode)  

Mode: Selection of the HDMI/TMDS mode (HDMI/DVI) 

Link Mode: Selection of TMDS Bit Period / TMDS Clock Period ratio (1/10 or 

1/40) (3G / 6G) 

Enable Scrambler: Control of Scrambling_Enable bit 

FRL Control  

Disable FRL: Disable FRL mode 

Capability Radio Buttons: Selection of the link mode used for FRL link training.  

FFE Max: Set the maximum FFE level (0 to 4) supported for each FRL rate 

LT Timeout: The time used for FLT Timer (default = 200 ms) 

LT Poll Timeout: Poll interval for FLT_update flag (default = 2 ms) 

 

Please click Link Training  to apply 
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FRL Status 

FRL Mode: FRL Mode used by UCD-4XX HDMI source 

LT Status: FRL link training status of UCD-4XX HDMI source 

FLT Update: Status of FLT_update flag in SCDC Update Flags register of the connected 

HDMI sink. 

FLT Ready:  Status of FLT_ready flag in SCDC Status Flags register of the connected 

HDMI sink. 

FRL Start: Status of FLT_start flag in SCDC Update Flags register of the connected 

HDMI sink. 

FLT No Timeout: Status of FLT_no_timeout flag in SCDC Source Test Configuration register 

of the connected HDMI sink. 

FRL Max: Status of FRL_Max flag in SCDC Source Test Configuration register of the 

connected HDMI sink. 

 

Lane Status Matrix  

LTP: Status of Lnx_LTP_req (x = 0 to 3) fields in SCDC Status Flags register of 

the connected HDMI sink 

Pattern: Link Training Pattern used (0 to 8) 

FFE Level: FFE level used (0 to 3) 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration  

Enable and disable HDCP 1.4 or HDCP 2.3 capability of UCD-422 and UCD-412 Sink. Duplicates of 

the controls found in HDCP tab. 

HPD (Bottom panel)  

The status LED indicates the state of the HPD signal Asserted (logical ¯high°) or De-asserted (logical 

¯low°). 
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Pattern Generator Tab 

 

Force EDID preferred 

timing after LT 

UCD reads the EDID of the connected Sink and after next LT enables to 

Stream 0 the timing listed in 18-byte descriptor 1 in VESA block of the 

sink®s EDID. 

Use timings from EDID UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings Please see chapter Manage Timings later in this manual. 

Total bitrate: Used link payload / Total link capability in Gbps (Pls see Note below). 

Auto-Apply To avoid sourcing invalid video mode combinations new settings are 

being validated when the user is clicking Apply. 

Automatic validation will be applied when Auto-Apply is checked. 

Apply Apply recent changes. 

 

Pattern Generator Status panel shows the Timing, Pattern (Name), CEF (color format and 

subsampling and colorimetry), BPC (bits per color), Status, and CRC value, for each active stream. 

Note: A full description of Minimum link configuration combinations for UCD standard video modes is 

available. Please contact Unigraf for details. 
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Pattern  

Configuration of the video sent in the corresponding stream  

(Controls vary between selected pattern type) 

Predefined Timings 

The list includes a set of common fixed video timings. Please find a list of the timings with their major 

details in Appendix C of this document. With Manage Timings function the user can add timings in 

the list and select which timings are shown in the selection. 

Color Depth 

Available color depths are: 6, 8, 10, 12 and 16 bpc. Color depth 6 bpc is only available when using 

RGB color format in DisplayPort or DisplayPort Alt Mode. 

Video Pattern 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled  you can have the links activated but no video data transferred. 

Note: When MST mode is selected, full selection of test patterns is available only in stream 0  

Filter 

Filter timings by specific vendors and resolutions. Timings can be sorted by Vendor ID or width. 

HDMI timings are sorted by VIC number by default. 

 

Custom Image Patterns 

BMP, PNG, and JPG files can be loaded from the PC to be used as custom images. 

Please refer to Link Pattern in description of DP and DP Alt Mode Reference Source Link tab later in 

this manual for sending special DisplayPort binary patterns in the link instead of video.  

Color Depth 

Predefined  

Timings 

Selected 

Pattern 

Color Format and Subsampling 

Pattern 

Option

s 
Colorimetry 

Load pattern file Loaded 

pattern file 

Bitmap scaling 

Quantization 

Range 

Filter 
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Bitmap Scaling 

When bitmap patterns are used, they can be used either in their original resolution, aligned to left top 

corner (=un-check Scale), or upscaled or downscaled to match the selected video resolution (=check 

Scale). 

Pattern Options 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 
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Pattern Scrolling  

When Pattern Scrolling is enabled, the pattern is moved horizontally and vertically between display 

scans. The function is available for all patterns except the following: Color Bars, Chessboard, Solid 

Color, Solid colors (white, red, green, blue), White V-Strips, Motion Pattern, DSC Pattern. 

Enable: Enable or disable pattern scrolling 

Horizontally X pixels: Horizontal step of the pattern movement in pixels  

(values in range -127¤0¤128, for YCbCr 4:2:2 even values).  

0 = no movement, positive values = pattern moves to the right. 

Vertically Y pixels: Vertical step of the pattern movement in pixels  

(even values in range ²127¤0¤128, for YCbCr 4:2:0 even values).  

0 = no movement, positive values = pattern moves up. 

Every N frame: Delay of pattern movement in display frames (values in range 0¤ 255).  

0 = no movement, 1 = move every frame, n = move every n:th frame. 

Note: Please click Apply to enable changes or check Auto-Apply. 
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Sourcing DSC Compressed Patterns  

UCD Pattern Generator function can source DSC content originating from pre-created DSC 

compressed files. DSC compressed pattern files can be created with a separate tool called DSC 

Compressor. It can be launched from Tools > DSC Compressor. 

 

Select the source bitmap file in Source File field. Define the Output Resolution, the color depth, 

compression ratio and number of horizontal and vertical slices in the frame. 

Source File: Source bitmap file to be compressed (JPG, PNG, PPM) 

Sink DSC capability registers: Click Update to read DPCD registers 0x60 to 0x6f from the connected 

Sink device 

Color Space: Color space of the output compressed file (RGB, YCbCr 4:4:4, 4:2:2, 

4:2:0, Simple 4:2:2) 

Color depth: Color space of the output compressed file (8, 10, 12, 16) 

Output resolution: Resolution of the output compressed file 

Resize mode: The way the DSC image is created from the Source file 

Compression ratio: Used compression ratio 

Horizontal slices: Nr. of slices horizontally (1 to 24 Slices) 

Vertical slices: Vertical slices (1 to 24 Slices, Custom)  

Custom vertical slices size: minimum 1, recommended 108 

YUV Color range: Selection of color range between Full range (Full) (0 to 255 at 8 bpc) 

and Limited Range (CTA) (16 to 235 at 8 bpc) 

Refresh: Refresh the list after adding a custom resolution 

Custom: Create a custom output resolution  

DSC Version: DSC version used (1.1, 1.2) 

Line Buffer Depth: Line buffer bit depth used to generate the bitstream. (8 to 16 bits, 

default 9 bits) 

Open storage folder: Open DSC temp folder defined in Tools > Options 

Start Compression: Start the compression process 
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Result of the compression process is saved in the same folder as the source file. The start of the file 

name is the same as the source bitmap file; resolution and color format are added to the end of the 

file name. 

Example:  

unigraf_default_image_16k.ppm >> 

unigraf_default_image_16k_1920x1080_YUV422_FULL_bpc8_bpp6.dsc 

To use the created DSC file in Pattern Generator, select pattern: Select DSC Image and click Select 

¤ to open file selection dialog. 

When a DSC image is selected as the pattern, UCD Console will automatically enable DSC, provided 

that the connected Sink device declares support for DSC in its DPCD. 

When Select DSC Image pattern is being transmitted and incompatible Horizontal and Vertical Active 

timings are set (Via Apply or Apply All), the user is presented with a dialog: H-Active and V-Active 

don®t match with DSC data. Do you want to upload image? 

 

 

 

 

 

Above, ¯Do you want to upload image?° is misleading and will be changed to ¯Continue to transmit 

image?°. 

If you select No, the new settings will not be applied. 

If you select Yes, the Pattern will continue to be transmitted. DSC data is transferred in the active 

window. To transfer all DSC data without loss, active video should be large enough for DSC 

compressed data (DSC_pic_height * DSC_pic_lenght / compression_ratio). MSA H-active should also 

not be less than DSC pic_height. 

MSA V-active parameters can be reduced without DSC corruption until active video area is no longer 

large enough to pass all DSC data. 

MSA V-active and H-active can be increased until HW limitation (pixel clock limit) and link bandwidth 

are reached. 
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Preview DSC image 

 

To preview an DSC image before it is applied to the pattern generator, select the eye icon. CRC and 

DSC CRC values will be indicated in the preview image. 
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Manage Timings  

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can be 

limited by un-checking the checkbox in the left edge of Name column. The timings will remain in the 

list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon  indicates that a timing is a 

fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon . 

New: Create a new custom timing based on the selected fixed timing. 

Delete: Delete the selected custom timing 

Save: Save changes in the selected custom timing. 

Revert: Undo all changes 

The dialog parameters will be sanity checked and will warnings issued for illegal combinations. 

HDMI Timing Generator  

 

HDMI Timings can be generated and applied via the Timing Generator group. 
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To do this select CTA or OVT timings radio button. Select desire RID and FR or VIC in combo boxes 

and then click the Generate button. 

The generated values will be reflected in the Frame parameters. Click Apply to set timing.  
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Playback Tab 
 

Playback allows for running predefined Playlist files. Playlist contains a set of Scenarios with definitions 

of the timing, video pattern, audio content and related metadata packets and their duration. 

 

Term Functionality 

Playlist 

Playlists (text files) specify the UCD devices 

and output protocol for transmission. It lists 

scenarios to be transmitted. 

Scenario 

Scenarios (text files) allow users to select 

video frames, metadata packets and audio 

to be transmitted and their order. 

Advanced Playlists 

Unigraf UCD devices can also be used as a 

compatibility test tools for dedicated 

standards such as Dolby Visionµ and 

HDR10+. Contact Unigraf for details. 

Note: Note that Playlists and Scenarios are protocol dependent.   
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Common Tab  

The Import button is for importing *.json files into the common tab treeview. Sample content on 

windows can abe found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\ 

basic_library.json. Be warned  that once imported, items cannot at present be removed. Actually you 

can but it involves using Windows Register Editor to remove values from (uninstall will not help): 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\Playback 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\MetadataScenario  

Sample playlists are included in UCD Console. Select a sequence (a scenario) from the playlists and    

press Run (or double click it) to play.  

The Run button lable changes to Stop as a Scenarios run. Press Stop to stop playing the scenario. 

Press Skip to skip to next scenario (available when there are multiple scenarios in a playlist) while 

playing. While the scenario is loading the Run button lable changes to Cancel to allow cancelation. 

Figure below shows a playlist being run that contains a prompt command which pops up a dialog. 

 

 

Status Log 

Scenario commands are listed in the Status Log  as they are run. 
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Selected Sequence 

Running scenario video and audio details and their sources are shown in the Selected Sequence 

group panel. 

Note that the triggered scenario or playlist to be run is the last selected: If an item was selected via 

the treeview, it is the triggered item to be run. If the Select button was used to select an item, it is the 

triggered item to be run (regardless of what is selected in the tree control).  

Press the Select button to load a playlist or scenario to be run (selecting a sample from the Sample 

Content treeview will load them as the playlist or scenario to be run). Also it will be the scanario used 

as a template if the Scenario Editor is launched: default scenario values will be set if a playlist is 

selected. 

Press the Editor button to launch the Scenario Editor (see below). 

The Selected Sequence parameters are the transmission stream parameters. 

 



  Generator Operation 

UCD-4XX User Manual ± UCD Console 3.8 67 
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Scenario Editor  

 Press the Select button above to select the scenario desired to use as a template for creating a new 

scenario. Press the Editor button to launch the Scenario Editor. The the dialog paramaters will be 

generated from the scenario file shown under the panel Source label (Philips FHD.txt as seen above). 

Press the Path :¤for setting the Video, Packets or Audio paths. 

Press OK to save. Your are presented with a save dialog. You need to navigate to a directory you can 

save to. Run Conssole 2 with administration rights  if you want to save to default locations on 

windows such as: C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Refer to Appendix H: Playlists and Scenarios later in this manual for details. 
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Metadata Tab  

The Metadata  tab is for creating scenarios with metadata. 

 

 

Select the Delete button to delete a scenario or the Generate button to launch the Custom Metadata 

Scenario dialog (shown below). 

 

Current Pattern Generator timing details are shown at the top. You can change the color mode 

(RGB444, YUV444, YUV422, YUV420) and color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc) via the 

dropdown combo boxes. 

Select the Add or Delete buttons to add or remove metadata from the scenareio. 

Check the Audio checkbox and then the Browse¤ button to add an audio file. Sampling, channels 

and bits can be selected via the combo boxes. 

The scenario Comment can be added in line edit box after the three dashes (---). 

Use the Content folder Browse¤ button to select save location. 

You can press Play to run the scenario, Export to save it or Cancel to cancel. 

Export will  create a folder something like Metadata1920x1080@60-RGB444-8bpc in the Content 

folder. In it you will find  generated files frame.svg (displaed while running), the metadata files you 

selected and a scenario.txt file. You may edit and rename these files. 

. 
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HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description of the tab. 

VRR/QMS tab 

 

Click Generate to generate custom VRR and QMS scenarios. Custom Scenario Generator window 

will open. 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse¤ to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc).  
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VRR settings 

In the VRR tab you can set the transition and scenario duration parameters. Different transition types 

are Fixed frame rate, Min and max and Gradual. When fixed frame rate is selected, the scenario is 

played at the minimum frame rate set in the first field. Please, note that when the fixed frame rate is 

selected, you can only select the number of times the frame is repeated. 

 

When min and max is selected, the output sceario will alter the framerate between the specified 

values. You can also set the duration for step in seconds and select how many times frames are 

repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

QMS settings 

In the QMS settings dialogue you find all the frame rates included in the QMS specification. Select 

which frame rates you want to inlcude in your scenario. Also select the step duration in cycles. In the 

lower left corner details of the scenario as shown. 
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Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop -down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse¤ Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clicking Play. When the scenario is ready for playing, the scenario 

generator window will close. You can now inspect the progress in the log in the playback tab as shown 

below. 

Adaptive -Sync tab  

 

Click Generate to generate custom Adaptive-Sync scenarios. Custom Scenario Generator window 

will open. 
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First you are asked to select the floder where the generated content will be stored. 

 

Click Browse¤ to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc).  

 

Adaptive-Sync settings 

In the Adaptive-Sync section you can set the transition and scenario duration parameters. Different 

transition types are Fixed frame rate, Min and max and Gradual.  

When fixed frame rate is selected, the scenario is played at the minimum frame rate set in the first 

field. In scenario duration, select how many times frame is repeated. 
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When min and max is selected, the output scenario will alter the framerate between the two values 

set in the drop down menus. You can also set the duration for step in seconds and select how many 

times frames are repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop -down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse¤ Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clickin Play. When the scenario starts playing, the scenario generator 

window will close. You can now inspect the progress in the log in the palyback tab as shown below. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV format. 

Audio is played to all active ports. 

To load internally generated audio, select Generate Audio, and adjust the controls to the desired 

audio format. 

To load an audio file from your PC, select Load Audio from File, click the Open WAV file¤ button, 

browse and select the file and Open. 
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The Compressed checkbox indicates that the audio loaded from the selected file is compressed. 

To play the selected audio content, click the Play. 

The content will be transmitted until the Stop button is clicked.  

Audio Status displays current audio content status.  

Audio Content  

Sent audio can be generated internally or used a WAV file loaded from the PC. 

In case of a WAV audio file, the parameters stored in the file will be used. When generating audio 

internally, the user sets the details of the LPCM Audio signal. 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental 

Signal Frequency Setting audio signal frequency in Hz. 

Sample Rate (Hz) Selection of audio sampling rate: 32000, 44100 (default), 48000, 

88200, 96000, 176400, 192000. 

Bits/Sample Selection of sample bit depth: 16, 20, 24. 

Amplitude(%) Selection of audio amplitude: 10%, 20%, ¤, 90%, 100%. 

Channels Audio channels available: 1, 2, ¤, 7, 8. 

Channels transmit LPCM (uncompressed) Audio. 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 
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Status  General  

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded: HDCP keys are loaded to the UCD unit. 

Km is stored: Master Key (Km) is stored. 

SST Mode Type Type when in SST mode. 

Status By stream  

Stream status (DP) shows HDCP status on each stream. 

Configuration  Control  

Enable encryption: Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Use stored Km: Use stored Master key (Km). 

Configuration type  

Select to configure HDCP (DP) or All streams at once or By stream. 

By stream  

Select and configure streams (DP). 

Type Value  

Select Type 0 or Type 1. Type 1 ensures that content encryption is done with HDCP version 2.2 or 

higher. 

Configuration Keys  

Select Production or Facsimile HDCP keys. To remove the keys, select None.  
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EDID Tab 
EDID Tab provides tools for accessing the EDID data of the connected sink device. There are three 

basic functions: 

¶ Load and save the data files in the host PC. 

¶ Edit the data contents either in Editor Mode or in Hex Edit Mode. 

¶ Read and write data to the connected sink. Up to 4 virtual channels can be accessed. 

EDID Files 

With Load¤ and Save As¤ a file can be read into the editor or written to a file from the PC.  

The contents of the device EDID file are not modified, or integrity checked during load and save 

operations. 

Note: Four blocks (512 bytes) of EDID code are read. If the device does not support all four blocks, the 

non-supported data values are set to zero. 

Text EDID 

In the Editor Panes (upper right pane), the Text EDID tabs allow viewing data in tree form. 

EDID/DisplayID  Editor  

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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Sink DUT Testing Tab 
Refer to Appendix E for descriptions of the tests available. The tests are presented in a split view, the 

left being test categories and the right being the tests within.  
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Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category (ex. DP 

1 .4 LL CTS) when running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 

 

On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 
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Test Parameters  

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters  

Test parameters can be saved in various ways. 

¶ Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

¶ Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

¶ Save parameters in Configure dialog as Presets later to be used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that importing and Exporting *.json files here have a different format than importing 

those described above. 
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 HDMI LINK TIMELINE VIEWER 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

 

HDMI Link Timeline Viewer is a tool for evaluating the content and timing of data captured via HDMI 

Link Analyzer functionality of UCD Console. 

HDMI Link Timeline Viewer has three tabs (for three modes):  

FrameView tab is the primary  tab for analyzing captured events on the timeline. 

Reports tab can be used to summarize events (AUX at present). 

Images tab lets the user view captured video frame images. 

 

 The FrameView tab and its views are shown below. 
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Wave Form View zoomed out and zoomed in views are shown below. Event periods are shown under 

the timeline (at the top) in their proper row as period rectangles with text descriptions (or abbreviations 

or no text, space permitting). Double-clicking a period rectangle will highlight the timeline portion of 

the rectangle and the row header(s) as shown below. To zoom the Wave Form View, position the cursor 

and use the mouse wheel to zoom in or out with respect to the cursor location. Drag to scroll the Wave 

Form View and the Symbols View horizontally.  
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Wave Form and Symbols View Settings 
Shown below are the WaveForms View and Symbols Views settings widgets. 

 

Gear Icon  

 

Select the Gear icon to select events to be displayed (+) or hidden (-). When Gear icon is selected, 

you can drag a row to reorder rows. 

 

 

Save Icon  

 

Select the Save icon to Save, Load or Remove named internal settings sets. You can also Import or 

Export named *.json files containing settings or Reset to default. 
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Zooming  

 

Select  Zoom + or ² icons to zoom in and out or use the mouse wheel. The zooming in/out option 

applies to Wave Form View only. 

Scrolling  

 

Use the arrow keys to navigate the timeline. One arrow moves the timeline one page, two arrows 10 

pages and three 100 pages. 

You can also scroll by dragging ( click and hold while dragging).  

Clock icon  

 

Move to a time point. Enter values and press OK. 

 

Eraser  

 

Removes all measurements on the timeline. 

 

Move  to Previous or Next Frame 

 

Move back or forward to the same relative location in the previous or next frame. 

Sync Data  

   Not synchronized.     Synchronized. 
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FrameView Tab 

Frame View tab has three tabs: Main Link Events, Symbols, and Log Events. 

The Main Link Events tab is the primary  tab for analysis and is presented first. 

Main Link Events Tab 
Main Link Events tab consists of five panels: Event Selector View, Event Details View, Wave Form 

View, Symbols View and Frame Image View. 

Each of these views are synchronized and actions in one will be reflected in others. 
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Event Selector View  

Event Selector View events are presented as a folding list of FRAMEs. Each FRAME contains a set of 

BLANK LINEs followed by a set of ACTIVE LINEs and finally by another short set of BLANK LINEs. 

BLANK LINEs contain items such as CTR periods and DATA ISLAND periods. DATA ISLANDs contain 

HDMI data packets such as GCP and AVI packets.  ACTIVE LINESs contain CTRL and VIDEO DATA 

items. 

 

 

 

The timing format used in Link Timeline Viewer consists of two timings based on time and bits. 

The time format is as follows:  

seconds:milliseconds.microseconds.nanoseconds.picoseconds 

In the image above you can see the time format on top and the bit format underneath (smaller grey 

font). 

When clicking on a Main Link Event, both Wave Form View and Symbol View are focused, and the 

time stamp block of the item is highlighted as shown below. 
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Event timing details are shown in the columns are the following: 

Type: Type of item. 

Id: Items occurrence number. 

Position: Start of the event from start of the captured data 

Duration: Duration of the event 

End: End of the event from start of the captured data 

Search 

You can search events by typing its name in the Search bar and pressing enter or by 

clicking the enter icon. The events are highlighted and shown in Wave Form View and 

Symbol View. 

 

 

 

 

Aa: Makes search function case sensitive. 

RExp: Use regular expressions. 

 

Click the enter icon to apply filters. 

 

 

Click Find Prev and Find Next icons to navigate. Also shown is the instance (here 

instance 2 out of 77). 
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The gear icon opens Configure search dialog. In addition to settings described above, 

you can select which colums are shown in Main Link Events window. 

 

 

 

   Not synchronized.     Synchronized. 

Click icons to synchronize data for view. 

 

 



  HDMI Link Timeline Viewer 

UCD-4XX User Manual ± UCD Console 3.8 93 
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Symbols Tab 
Symbols View lists all PERIODS. 

 ­ 

 

 

Selection and multiview highlighting behavior is as for Main Link Events above. 

Search criteria are the same as for Main Link Events above. 

Each column has a sort and filter icon. Shown below is for the Type sort and filter icon. 
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Event Details View 
The event details are shown in the lower left panel. The event details consists of two tabs: Image tab 

and Details tab. 

Details  Tab 

The information shown in the Details tab depends on the selected item. A FRAME item is shown 

below. 

  

Images Tab 

 

Image for currently selected FRAME can be viewed (only when FRAME is selected). 
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Wave Forms View 
Wave Form View consists of two tabs: Wave Forms and Spatial View. 

Wave Forms  Tab 

Wave Form View looks different depending on zoom level. Images below show the views in zoomed 

out and zoomed in states. 

Event periods are shown under the timeline (at the top) in their proper row as period rectangles with 

text descriptions (or abbreviations or no text, space permitting). Double-clicking a period rectangle 

will highlight the timeline portion of the rectangle and the row header(s). To zoom the Wave Form 

View, position the cursor and use the mouse wheel to zoom in or out with respect to the cursor 

location. Drag to scroll the Wave Form View and the Symbols View horizontally. 
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Columns are: 

HPD Hot Plug Detect signal. 

I2C I2C Events and signals sda and scl 

CEC: CEC Events and Signal 

Link Link type (TMDS SCRAMBLED for ex.) 

Periods INVALID, CTL, DATA, VIDEO, SSCP, HDCP, KEEP_OUT 

Sync HSYNC and VSYNC periods and signals 

Frame Frame number. 

Lines ACTIVE and BLANK lines 

Packets GCP and AVI packets 

PHY Lane 0 Lane 0 data 

PHY Lane 1 Lane 1 data 

PHY Lane 2 Lane 2 data 

 

The scroll bar at the top shows all captured frames. Select a frame by double-clicking. 

 

 

As you hover over the timeline, a timestamp for that position is displayed on the timeline at the cursor 

horizontal location. 

Popups show details of events as you hover over them in Wave Form View. 

Below illustrates how the different views align when you double click in the Wave Form View or the 

Symbols View. 
















































































































































































